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Notices
© Agilent Technologies, Inc. 2010

No part of this manual may be reproduced 
in any form or by any means (including 
electronic storage and retrieval or transla-
tion into a foreign language) without prior 
agreement and written consent from Agi-
lent Technologies, Inc. as governed by 
United States and international copyright 
laws.

Warranty

The material contained in this docu-
ment is provided “as is,” and is sub-
ject to being changed, without notice, 
in future editions. Further, to the max-
imum extent permitted by applicable 
law, Agilent disclaims all warranties, 
either express or implied, with regard 
to this manual and any information 
contained herein, including but not 
limited to the implied warranties of 
merchantability and fitness for a par-
ticular purpose. Agilent shall not be 
liable for errors or for incidental or 
consequential damages in connection 
with the furnishing, use, or perfor-
mance of this document or of any 
information contained herein. Should 
Agilent and the user have a separate 
written agreement with warranty 
terms covering the material in this 
document that conflict with these 
terms, the warranty terms in the sep-
arate agreement shall control.

Technology Licenses 

The hardware and/or software described in 
this document are furnished under a 
license and may be used or copied only in 
accordance with the terms of such license.

Restricted Rights Legend

If software is for use in the performance of 
a U.S. Government prime contract or sub-
contract, Software is delivered and 
licensed as “Commercial computer soft-
ware” as defined in DFAR 252.227-7014 
(June 1995), or as a “commercial item” as 
defined in FAR 2.101(a) or as “Restricted 
computer software” as defined in FAR 
52.227-19 (June 1987) or any equivalent 
agency regulation or contract clause. Use, 
duplication or disclosure of Software is 
subject to Agilent Technologies’ standard 
commercial license terms, and non-DOD 
Departments and Agencies of the U.S. Gov-
ernment will receive no greater than 
Restricted Rights as defined in FAR 
52.227-19(c)(1-2) (June 1987). U.S. Govern-
ment users will receive no greater than 
Limited Rights as defined in FAR 52.227-14 

(June 1987) or DFAR 252.227-7015 (b)(2) 
(November 1995), as applicable in any 
technical data.

Safety Notices

CAUTION

A CAUTION notice denotes a haz-
ard. It calls attention to an operat-
ing procedure, practice, or the like 
that, if not correctly performed or 
adhered to, could result in damage 
to the product or loss of important 
data. Do not proceed beyond a 
CAUTION notice until the indicated 
conditions are fully understood and 
met. 

WARNING

A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or 
the like that, if not correctly per-
formed or adhered to, could result 
in personal injury or death. Do not 
proceed beyond a WARNING 
notice until the indicated condi-
tions are fully understood and met.
Trademarks

Windows 2000®, Windows XP®, and 
Microsoft .NET Framework 1.1® are U.S. 
registered trademarks of Microsoft Corpo-
ration.

Installation Guides

You can find the installation guides for 
different components of the product on the 
product CD. Agilent recommends you to do 
not switch on the instrument before you 
have understood all the applicable 
installation instructions and have met all 
the installation prerequisites.

Where to find more information

You can find more information about 
Protocol Analyzer from the following link:

http://www.agilent.com/find/spt

For further assistance, you can search for a 
local contact on the following link:

http://www.agilent.com/find/assist



Safety Symbols on Instruments
Indicates warning or caution. If you 
see this symbol on a product, you 
must refer to the manuals for 
specific Warning or Caution 
information to avoid personal injury 
or damage to the product.

Frame or chassis ground terminal. 
Typically connects to the 
equipment’s metal frame.

Indicates hazardous voltages and 
potential for electrical shock.
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Indicates that antistatic 
precautions should be taken.

Indicates hot surface. Please do 
not touch.

Indicates laser radiation turned on.

CSA is the Canadian certification 
mark to demonstrate compliance 
with the Safety requirements.
CE compliance marking to the EU 
Safety and EMC Directives.

ISM GRP-1A classification 
according to the international EMC 
standard.

ICES/NMB-001 compliance 
marking to the Canadian EMC 
standard.
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Safety Summary

General Safety Precautions

The following general safety precautions must be observed during all phases of operation of this instrument. 
Failure to comply with these precautions or with specific warnings elsewhere in this manual violates safety 
standards of design, manufacture, and intended use of the instrument.

Agilent Technologies Inc. assumes no liability for the customer's failure to comply with these requirements.

Before operation, review the instrument and manual for safety markings and instructions. You must follow these 
to ensure safe operation and to maintain the instrument in safe condition.

General

This product is a Safety Class 1 instrument (provided with a protective earth terminal). The protective features of 
this product may be impaired if it is used in a manner not specified in the operation instructions.

All Light Emitting Diodes (LEDs) used in this product are Class 1 LEDs as per IEC 60825-1.

Environment Conditions

This instrument is intended for indoor use in an installation category II, pollution degree 2 environment. It is 
designed to operate at a maximum relative humidity of 95% and at altitudes of up to 2000 meters.

Refer to the specifications tables for the ac mains voltage requirements and ambient operating temperature 
range.

Before Applying Power

Verify that all safety precautions are taken. The power cable inlet of the instrument serves as a device to 
disconnect from the mains in case of hazard. The instrument must be positioned so that the operator can easily 
access the power cable inlet. When the instrument is rack mounted the rack must be provided with an easily 
accessible mains switch.

Ground the Instrument

To minimize shock hazard, the instrument chassis and cover must be connected to an electrical protective earth 
ground. The instrument must be connected to the ac power mains through a grounded power cable, with the 
ground wire firmly connected to an electrical ground (safety ground) at the power outlet. Any interruption of the 
protective (grounding) conductor or disconnection of the protective earth terminal will cause a potential shock 
hazard that could result in personal injury.

Do Not Operate in an Explosive Atmosphere

Do not operate the instrument in the presence of flammable gases or fumes.

Do Not Remove the Instrument Cover

Operating personnel must not remove instrument covers. Component replacement and internal adjustments must 
be made only by qualified personnel.

Instruments that appear damaged or defective should be made inoperative and secured against unintended 
operation until they can be repaired by qualified service personnel.
4 Protocol Exerciser User’s Guide
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Printing History
Agilent Technologies, Inc. can issue revisions between the product releases to reflect the latest and correct 
information in the guide. Agilent Technologies, Inc. also reserves its right to not issue a new edition of the guide 
for every system release.

The name of the guide and its part number are:

Manual Name: Agilent Protocol Exerciser for PCI Express - User’s Guide

Manual Part Number: N5308A-91010

The edition number of the guide, publishing time of the guide, and applicable release number of the product are 
given in the following table.

Edition Published Applicable Release

1 June, 2010 8.1
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Agilent Protocol Exerciser for PCI Express
User’s Guide
What’s New in this Release

This is the first release of Agilent Protocol Exerciser for PCI 
Express for Gen3 PCIe devices. The LTSSM Tester tool is the 
focus of this release for effective and thorough link testing. 
The following are the new/key features of this release of the 
product.

• Testing link negotiation, initialization and training 
according to the PCIe specifications for Gen1, Gen2, and 
Gen3 PCIe devices.

• Support for training sequences exchange at 8.0 GT/s, 5 
GT/s or 2.5 GT/s speeds on all lanes for link width up to 
x16.

• Gen3 LTSSM state transitions available while performing 
LTSSM functions.

• Support for training the link to Gen3 (8.0 GT/s) with 
options to test with 1st phase or all phases of 
Equalization or without Equalization.

• Link speed upgrade and downgrade across the Gen1, 
Gen2, and Gen3 speeds on a configured link.
11Agilent Technologies
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Agilent Protocol Exerciser for PCI Express
User’s Guide
1
Agilent Protocol Exerciser for PCI 
Express - Introduction

What is Protocol Exerciser for PCI Express    14

Protocol Exerciser for PCI Express Modes (As Exerciser and as 
LTSSM)    17

When to use Protocol Exerciser for PCI Express    18

Protocol Exerciser for PCI Express Components    19

This chapter introduces you to Protocol Exerciser for PCI 
Express and provides information on its emulation modes, 
features, uses, and its hardware and software components.
13Agilent Technologies



1 Agilent Protocol Exerciser for PCI Express - Introduction
What is Protocol Exerciser for PCI Express
14
Agilent Protocol Exerciser for PCI Express (PCIe) provides a 
test and debug solution for PCI Express, helping the 
industry to test the next generation of PCI Express 
technology. It can emulate any PCIe device and topology and 
can provide test conditions to test components on system 
boards and cards.

Protocol Exerciser can function as an Exerciser and a Link 
Training and Status State Machine (LTSSM) with a PCIe 
system or a PCIe device under test. This release of Protocol 
Exerciser focuses on its LTSSM mode and supports all the 
necessary LTSSM functions to test a DUT's LTSSM under 
various scenarios. The subsequent releases of Protocol 
Exerciser will increment its features as an Exerciser as well. 

The following figure illustrates its coverage in terms of the 
OSI standard model.

Figure 1 Protocol Exerciser coverage

Refer to the topic Protocol Exerciser for PCI Express Modes 
(As Exerciser and as LTSSM) on page 17 to know more 
about its functions as an Exerciser and an LTSSM.
Protocol Exerciser User’s Guide



Agilent Protocol Exerciser for PCI Express - Introduction 1
Features of Protocol Exerciser
Protocol Exerciser User’s Guide
A brief list of the features of Protocol Exerciser is given 
below:

• Performs link negotiation, initialization and training, data 
link layer functions, and handles incoming requests 
according to the Gen3 specifications.

• Addresses the industry's need for LTSSM testing by 
providing the LTSSM Tester tool for effective link 
negotiation testing:

• Thorough link testing with LTSSM Tester.

• Exercising DUT with the x16 Protocol Exerciser.

• Generates training sequences at 8.0 GT/s, 5 GT/s, and 2.5 
GT/s speed on all lanes for link width up to x16, which 
allows effective link negotiation testing.

• Enables root complex emulation, Endpoint emulation, and 
add- in card testing at link widths x1 to x16. 

• Enables you to perform protocol checks by selecting the 
PCIe protocol rules that you want to observe for violation. 
Emulation Modes
The Agilent Protocol Exerciser for PCI- Express can emulate 
a PCI Express end point (as a DSC) to exercise the System 
Under Test (SUT) acting as a root complex. It can also act as 
a root complex (USC) to test a PCI Express end point. In 
both cases, a controlling system is needed that hosts the 
Protocol Exerciser software to manage and control the 
Exerciser card. 

As an endpoint

In this mode, the Agilent Gen3 exerciser card is plugged into 
the motherboard, as a normal PCIe device. You can use 
multiple exerciser cards to load and stress a server system 
under test. You can connect up to four Exerciser cards to 
one system controller through USB. 

As a root complex

In this case, the exerciser communicates to the DUT through 
the backplane board. When you use the backplane, Protocol 
Exerciser communicates to the DUT through the bottom 
connectors.
15
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1 Agilent Protocol Exerciser for PCI Express - Introduction
Another way is to connect the DUT through the top 
connector daughter board.  In this mode, the link width 
would be limited. However, this would be the preferred test 
method of compliance test, in order to limit the link width.

The following figure demonstrates a sample setup of a 
Protocol Exerciser card emulating an endpoint and a root 
complex.
Figure 2 Protocol Exerciser Card Sample Setups

Refer to the Installation guide for the Protocol Exerciser for PCIe Express 
NOTE
to know how to set up the Protocol Exerciser hardware to emulate as a 
root complex or as a PCIe endpoint.
Protocol Exerciser User’s Guide



Agilent Protocol Exerciser for PCI Express - Introduction 1
Protocol Exerciser for PCI Express Modes (As Exerciser and as LTSSM)
Protocol Exerciser User’s Guide
Protocol Exerciser can function as an Exerciser as well as an 
LTSSM. 

As an LTSSM, you can use it for thorough link testing with 
DUT and exchanging training sequences to test and validate 
LTSSM state transitions. 

As an Exerciser, it exercises DUT with appropriate PCIe 
traffic.

This release of Protocol Exerciser focuses on its LTSSM 
mode and supports all the necessary LTSSM functions to 
test a DUT's LTSSM under various scenarios. The subsequent 
releases of Protocol Exerciser will increment its features as 
an Exerciser as well.

To know more about its LTSSM mode and how to use it for 
LTSSM testing, refer to the chapter Testing Link 
Initialization, Training, and Management on page 68.
17



1 Agilent Protocol Exerciser for PCI Express - Introduction
When to use Protocol Exerciser for PCI Express
18
Usage as a Protocol Exerciser 

By emulating a PCIe endpoint or a root complex, Protocol 
Exerciser acts as an ideal link partner by sending 
appropriate I/O traffic to stimulate the DUT. This way, it can 
help you test DUT under various conditions and scenarios 
without influencing the performance parameters of DUT. 

Usage as an LTSSM

One of the key challenges with PCI Express is the validation 
testing for the LTSSM functions and thorough link testing 
supporting the Gen3 high speed. Protocol Exerciser in its 
mode as an LTSSM provides you LTSSM functions to test 
DUT's LTSSM. You can use various LTSSM tests that it 
provides to force DUT into various LTSSM states and verify 
the state transitions and timeout implementations.

In this release, Protocol Exerciser is used primarily for 
LTSSM testing.

To know more about its usage as an LTSSM, refer to the 
topic When to Use LTSSM Tester on page 60.
Protocol Exerciser User’s Guide



Agilent Protocol Exerciser for PCI Express - Introduction 1
Protocol Exerciser for PCI Express Components
Protocol Exerciser User’s Guide
This topic describes the hardware and software components 
of Protocol Exerciser.
Hardware Components
U4305A Exerciser Card

The U4305A Exerciser card acts as both a Protocol Exerciser 
as well as an LTSSM for upto x16 link widths. This card 
supports simultaneously use of LTSSM and Protocol 
Exerciser functions, without requiring any configuration. For 
this release, you can use this card to perform LTSSM testing.

The following figure shows the U4305A exerciser card.
Figure 3 U4305A Exerciser Card

Refer to the Hardware guide for the Protocol Exerciser for PCIe Express to 
NOTE
know more about the U4305A Exerciser card.
19
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While setting up the hardware for Protocol Exerciser, you 
can mount this card on the System under Test (SUT) to 
stimulate SUT with PCIe testing scenarios. You can also set 
up this card as a root complex by mounting it on the 
backplane board and communicating with the DUT through 
this passive backplane. 
Software Components

NOTE Refer to the Installation guide for the Protocol Exerciser for PCIe Express 
to know how to set up the Protocol Exerciser hardware to emulate as a 
root complex or as a PCIe endpoint.
When you install Protocol Exerciser, the following software 
components are installed.

• Protocol Exerciser GUI -  You can use the Protocol 
Exerciser GUI to control, manage, and use the Protocol 
Exerciser card. Following are the primary functions of the 
Protocol Exerciser GUI.

• Create and manage setup files for Protocol Exerciser

• Create a link between DUT and Protocol Exerciser

• Run LTSSM tests provided to test DUT's LTSSM 
functions

• View and update the link and Exerciser hardware 
status

To know about the Protocol Exerciser GUI components, 
refer to the topic Protocol Exerciser GUI Components on 
page 28.

• Protocol Exerciser API -  Protocol Exerciser provides a 
set of APIs to allow you to control, manage, and use 
Protocol Exerciser programmatically through these APIs. 
Refer to the API Reference guide to know about the usage 
of these APIs.

• Firmware Update tool -  You use this tool to update the 
Firmware version for an Exerciser card. To know more, 
refer to the topic, Using the Firmware Update Tool on 
page 104.
NOTE This guide covers only the GUI aspect of Protocol Exerciser. For 
information on API, please refer to the API Reference guide. 
Protocol Exerciser User’s Guide



Agilent Protocol Exerciser for PCI Express
User’s Guide
2
Getting Started with Protocol Exerciser

Creating a Protocol Exerciser Session    22

Starting and Exiting the Protocol Exerciser GUI    26

Protocol Exerciser GUI Components    28

Viewing and Updating the Protocol Exerciser Hardware Status    30

Managing Floating Windows    32

This chapter describes the tasks that you should perform 
before you get started with using Protocol Exerciser to test a 
DUT. This chapter also introduces you to the main screen 
components of the Protocol Exerciser application and how to 
access it. 
21Agilent Technologies



2 Getting Started with Protocol Exerciser
Creating a Protocol Exerciser Session
22
You can access Protocol Exerciser in either Offline or Online 
mode. This topic describes the Offline and Online modes of 
using the Protocol Exerciser GUI.
Protocol Exerciser Online mode
When you want to use Protocol Exerciser in an online mode, 
you either create a new Protocol Exerciser session with the 
controller PC or use an existing session on the controller PC. 
A controller PC hosts the Protocol Exerciser software and 
hardware support services and connects to the Exerciser 
card(s) through a USB. A Protocol Exerciser session forms 
the basis of communication between the controller PC and 
exerciser cards, and also initializes the necessary firmware. 
Once a session is created, you can control and manage the 
installed exerciser card(s) using the Protocol Exerciser GUI.

Multiple clients can remotely connect to a single Protocol 
Exerciser session on the controller PC.

The following figure displays a Protocol Exerciser session 
scenario in which Session A and Session B have been 
created on the controller PC with two Protocol Exerciser 
cards connected to the controller PC through USB.  Two 
clients are accessing Session A and one client is accessing 
Session B.
Protocol Exerciser User’s Guide
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Figure 4 Protocol Exerciser Sessions

In an online session, you generate real- time PCIe traffic to 
exercise a DUT.  Therefore, before you start an online 
session, ensure that at least one exerciser card is connected 
with the Controller PC. Ending an online session releases 
the hardware resources of Protocol Exerciser, thereby 
enabling these to be used for a new session.
Protocol Exerciser Offline mode
When you want to use Protocol Exerciser in an offline mode, 
you do not need to create a session between the Controller 
PC and an Exerciser card. You generally use an offline mode 
when you do not have an established connection with any 
external hardware device. However, you want to create 
configuration specifications to be used later when an online 
session is established.

Some options in offline mode are disabled due to their 
dependency on the connected hardware. For instance, the 
Hardware status is not displayed in the offline mode.

Protocol Exerciser does not enable you to lock a session 
(online or offline). Therefore, it is possible for multiple 
Protocol Exerciser instances to concurrently access a single 
session.
Creating/Using a Protocol Exerciser Session

NOTE The controller PC does not protect against meaningless, or even 
conflicting requests. Therefore, it is recommended that only one user 
should own a particular session at a time.
While accessing the Protocol Exerciser GUI, you need to 
select whether you want to connect to a new or an existing 
Protocol Exerciser session or you want to use the GUI in an 
offline mode. 

The Select type of connection dialog box helps you specify 
the mode of accessing Protocol Exerciser and the session 
related information if an online mode is needed. This dialog 
box is displayed when you try to access the Protocol 
Exerciser GUI.
23
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2 Getting Started with Protocol Exerciser
Figure 5 Select type of connection dialog box

Working in an offline mode

In the Select type of connection dialog box, select the 
Offline mode radio button and click Start.

Using an existing Protocol Exerciser session

1 Select the Connect to existing session radio button.

2 In the Server text box, specify the name or IP address of 
the controlling server that hosts the Protocol Exerciser 
software and on which you want to use an existing 
session.

The Session list listbox displays the list of Protocol 
Exerciser sessions existing on the specified server.

3 Select a session from the Session list listbox.

4 Click Start.

Creating a new Protocol Exerciser session

1 Select the Connect to new session radio button.

2 In the Server text box, specify the name or IP address of 
the controlling server that hosts the Protocol Exerciser 
software and on which you want to create a new session.

3 Click Start.
Protocol Exerciser User’s Guide
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The Port Selection dialog box is displayed. It displays a 
list of ready to use as well as already in use serial I/O 
exerciser modules along with their type in terms of link 
speed supported, and the available number of ports. Here, 
you can only select an exerciser module, which is not in 
use.
Figure 6 Port Selection dialog box

4 Select the appropriate Exerciser module and then select 
the available port of the selected Exerciser module from 
the Select Port to use listbox.

5 Click OK.

At any time, you can access the session information by 
clicking the Help - > Session Information menu option in the 
Protocol Exerciser GUI.
25



2 Getting Started with Protocol Exerciser
Starting and Exiting the Protocol Exerciser GUI
26
To access Protocol Exerciser GUI 

1 On the Windows task bar, click Start > Programs > 
Agilent SPT > PCIe Exerciser 8.1 Release > Exerciser 
GUI.

The Select type of connection dialog box appears.

2 Select the Protocol Exerciser mode in which you want to 
use the GUI (Online or offline). If you want to use the 
GUI in an online mode, then either create a new session 
or join an existing session on the controller PC that hosts 
the Protocol Exerciser software and is connected the 
exerciser card hardware. Refer to the topic Creating a 
Protocol Exerciser Session on page 22 to know more 
about sessions.

The main Protocol Exerciser window is displayed.

Depending on the selected mode of usage (online or offline), 
some GUI features are enabled/disabled. 

Exiting Protocol Exerciser GUI

To exit from the Protocol Exerciser GUI:

1 Click File > Exit.

The Changes not applied message appears if you had not 
applied all the changes made to Protocol Exerciser.

2 Do one of the following:

• Click Yes to apply all the unapplied changes before 
closing the Protocol Exerciser window.

• Click No to close the Protocol Exerciser window 
without applying the unapplied changes.

• Click Cancel to quit the message box and return to 
Protocol Exerciser.

Clicking Yes or No displays a message box that prompts 
to save the settings of the current session in a file.

3 Do one of the following:

• Click Yes to save the underlying Protocol Exerciser 
settings before exiting.

• Click No to close the Protocol Exerciser window 
without saving the underlying Protocol Exerciser 
settings.
Protocol Exerciser User’s Guide
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Protocol Exerciser User’s Guide
• Click Cancel to quit the message box and return to 
Protocol Exerciser.

Completing this message box displays the Closing Session 
dialog box.

4 Do one of the following:

• Click Yes to remove the associated session before 
closing the Protocol Exerciser window.

• Click No to close the Protocol Exerciser window 
without removing its associated session.
NOTE Closing a session automatically makes all the GUI interfaces that are 
connected to it, inaccessible.
27



2 Getting Started with Protocol Exerciser
Protocol Exerciser GUI Components
28
This topic describes various components of the Protocol 
Exerciser GUI to help you understand how it is organized in 
various pane, the purpose of each pane, and how to access 
these panes.

The following figure displays the Protocol Exerciser 
application main window with its main components.
Figure 7 Protocol Exerciser window

The main components of the Protocol Exerciser window are 
briefly described below:
Protocol Exerciser User’s Guide
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• Menu Bar and Toolbar: These provide easy and quick 
access to the features of the Protocol Exerciser 
application.

• Navigation Pane: Displays the features of Protocol 
Exerciser as various icons. Using this pane, you can 
access and  navigate through various features of Protocol 
Exerciser.

• Configuration Area: Displays the existing settings and 
allows you to specify the new settings for the Protocol 
Exerciser feature currently selected in the Navigation 
pane. 

• Status Bar: Displays the current status of the various 
Protocol Exerciser activities, such as user level (User or 
Expert), session status (offline or online), and exerciser 
status (offline or online).

• Hardware Status pane: Displays the Protocol Exerciser 
hardware status and the link status. The information in 
this pane is updated automatically when you perform any 
function or run a test that impacts the hardware and link 
status. 

You can view/hide a pane using the View menu.
29



2 Getting Started with Protocol Exerciser
Viewing and Updating the Protocol Exerciser Hardware Status
30
You can get information about the Protocol Exerciser 
hardware status and the link status using the Hardware 
Status pane of the Protocol Exerciser GUI. 

The information in this pane is updated when you perform 
any function or run a test that impacts the link partners 
and link status. For instance, when the link between the 
DUT and Protocol Exerciser is not up, the link status is 
displayed as No Link. When you perform the steps to 
initialize this link, the link status is updated to Active if the 
procedure is completed successfully. If needed, you can also 
manually update the status on this pane using the Update 
Status Manually button after performing a specific action 
and to see its impact on the status. Consider a situation 
when you changed the link width to x4 from x16 in the Link 
settings page and then initialized the link with this new lane 
width setting. You can check if the link width is changed to 
x4 using the Hardware status window. 

To access the Hardware Status pane:

• Click View > Hardware Status.

The Hardware Status pane appears. A sample screen is 
displayed.

Figure 8 Hardware Status pane

This pane has the following information:
Protocol Exerciser User’s Guide
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• Status -  The status tab provides you the following 
information:

• The current state of the PCIe Link between DUT and 
Exerciser.

• The link width at which the link is presently active.

• The current speed of the underlying link.

• The advertised data rate capabilities of the Protocol 
Exerciser.

• The received data rate, that is the data rate 
capabilities of the DUT.

• The received state of polarity for each lane.

• Update Status Manually: Click to refresh the data 
displayed in the Status tab.
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The main Protocol Exerciser window contains many floating 
windows. These windows can float anywhere on the desktop, 
or you can dock them together with other windows on the 
main Protocol Exerciser window. In the default window 
arrangement, all windows are properly docked on the main 
Protocol Exerciser window.

In this section, you will learn:

• To Display a Floating Window

• To Hide a Floating Window

• To Auto- Hide a Floating Window

• To Change a Docked Window to a Floating Window

• To Dock a Floating Window

To Display a Floating Window

• Click View > menu_command_for_floating_window.

Here, menu_command_for_floating_window represents 
the name of the menu command to access the floating 
window. For example, Hardware Status is a floating 
window. To display it, click the View > Hardware Status 
menu command.

To Hide a Floating Window

• Click the  icon on the title bar of the floating window.

You can also hide a floating window by clicking its menu 
command in the View menu.

To Auto-Hide a Floating Window

• Click the  icon on the title bar of the floating window.

This automatically hides the floating window when you 
are not using it. This also displays a new  icon on the 
title bar of the floating window.

To display the window again, place the cursor over the 
tab displayed for the hidden window, or click its menu 
command in the View menu.

To Change a Docked Window to a Floating Window

• Double- click the title bar of the docked window.
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To Dock a Floating Window

• Double- click the title bar of the floating window.
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Creating and Managing Protocol Exerciser Setup Files    36

Configuring a PCIe Link Settings    37

Configuring Lane Settings    39

Configuring Equalization Procedure Settings    41

Configuring Transceiver Settings    46

Configuring External Triggers Settings    47

This chapter provides information on the various settings 
that you can configure in the General tab of the Protocol 
Exerciser GUI to customize its functions according to your 
specific requirements. The help book also describes how to 
create and manage a Protocol Exerciser setup file.
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Creating and Managing Protocol Exerciser Setup Files
36
Protocol Exerciser performs its functions as an Exerciser 
and an LTSSM based on the settings that you configure in 
the Protocol Exerciser GUI. These settings are used by 
Protocol Exerciser to configure a session with DUT for 
functions such as link and lane negotiations, exchanging 
training sequences, performing equalization, and link speed 
changes. 

Protocol Exerciser saves these settings in the Protocol 
Exerciser setup file. You can create multiple versions of this 
file for multiple Exerciser cards with different link, lane, and 
other settings to use these versions in different testing 
scenarios with DUTs. For instance, you can create different 
setup files for an Upstream and a Downstream session with 
DUT and use these files based on whether Protocol Exerciser 
is emulating a root complex (as USC) or a PCIe endpoint (as 
DSC). You may also want to have different setup files for a 
session type with different link speed or lane width settings 
to test link negotiations with different link settings 
scenarios.

Ensure that you have created the Protocol Exerciser setup 
file with the required settings before starting link up 
between the DUT and Protocol Exerciser.

To create a Protocol Exerciser setup file, click the General 
icon in the Navigation window of the Protocol Exerciser GUI 
and then click the relevant tabs on the screen to configure 
various settings. Save the file with an appropriate name. The 
Protocol Exerciser setup files are saved with an .exs 
extension.

Using the File menu options, you can open, close, or save a 
Protocol Exerciser setup file. 
NOTE Some fields in the General tab pages are disabled if you are using Protocol 
Exerciser in an offline mode. Also, if the Protocol Exerciser is used as a 
DSC (based on the configured session type), some fields which are not 
applicable for Protocol Exerciser as a DSC are disabled. 

Refer to the Protocol Exerciser GUI Reference help topics in this online 
help to get a detailed description of each field in the tab pages. 
Alternatively, click the Help button displayed in the tab page to get a 
context-sensitive help page.
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Before you can create/initialize a PCIe link between Protocol 
Exerciser and DUT for normal exchange of data packets, you 
need to configure the settings for this link. This ensures that 
Protocol Exerciser initializes the link as per your specific 
link settings. 
NOTE Protocol Exerciser saves the link settings in an Exerciser setup file. You 
can create multiple versions of this file with different link, lane, and other 
settings to use these versions in different testing scenarios with DUTs. To 
know more, refer to Creating and Managing Protocol Exerciser Setup Files 
on page 36.
To configure the link settings, click the General icon in the 
Navigation window of the Protocol Exerciser GUI and then 
click the Link settings tab. 
NOTE Refer to the Protocol Exerciser GUI Reference help topics in this online 
help to get a detailed description of each field in this tab page. 
Alternatively, click the Help button displayed in the tab page to get a 
context-sensitive help page.
Some fields in this tab page are disabled if you are using 
Protocol Exerciser in an offline mode. Also, if the Protocol 
Exerciser is used as a DSC (based on the configured session 
type), some fields which are not applicable for Protocol 
Exerciser as a DSC are disabled.

The following are some of the points to be considered when 
configuring link settings.

• You select the session type based on whether you want 
the Protocol Exerciser to act as a USC or a DSC for the 
session. When Protocol Exerciser is emulating a root 
complex and acting as a USC, the session type should be 
To Downstream. The DUT is at the end point in this 
case. When Protocol Exerciser is emulating a PCIe end 
point and acting as a DSC, the session type should be To 
Upstream. The DUT is at root- complex in the hierarchy in 
this case.

• Select the data rate capabilities of the Protocol Exerciser 
based on the link speed scenarios that you want to test. 
The data rate capabilities options are disabled in the 
offline mode of Protocol Exerciser.
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• Protocol Exerciser performs data scrambling as per the 
PCIe specifications. At Gen1 and Gen2 speeds, you can 
enable or disable scrambling using the Link settings page. 
If you disable scrambling, Protocol Exerciser generates 
and responds to training sequences with the “disable 
scrambling” bit set, which causes the link to operate 
without scrambling. The disabling takes effect the next 
time Protocol Exerciser exchanges Training sequences 
after you select the Disable Scrambling option. At the 
Gen3 speed, scrambling is always enabled to follow the 
new Gen3 Scrambling Rules as listed in the PCIe 
specifications. Therefore, the Enable/Disable Scrambling 
option is not provided for the Gen3 speed. 

• If the data rate capabilities of both the link partners is 
8.0 GT/s and you want to initialize the link to 8.0 GT/s, 
then ensure that the Autonomous speed change to 8 
GT/s option in the Link Settings tab is selected. Selecting 
this check box autonomously moves the link speed to 8.0 
GT/s during link training.
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Before you can create/initialize a PCIe link between Protocol 
Exerciser and DUT for normal exchange of data packets, you 
need to configure the lane settings for this link. This ensures 
that the lanes of a port are associated and configured into a 
link through link width and lane negotiation as per the 
specified lane settings.
NOTE Protocol Exerciser saves the lane settings in an Exerciser setup file. You 
can create multiple versions of this file with different link, lane, and other 
settings to use these versions in different testing scenarios with DUTs. To 
know more, refer to Creating and Managing Protocol Exerciser Setup Files 
on page 36.
To configure the lane settings, click the General icon in the 
Navigation window of the Protocol Exerciser GUI and then 
click the Lane settings tab. 
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NOTE Refer to the Protocol Exerciser GUI Reference help topics in this online 
help to get a detailed description of each field in this tab page. 
Alternatively, click the Help button displayed in the tab page to get a 
context-sensitive help page.
The number of lanes displayed in the Lane settings page 
depend on the Link Width that you selected in the Link 
settings page.

Lane Reversal 

You can enable or disable the lane reversal feature for the 
Transmitter. Protocol Exerciser can reverse its lanes before 
starting the link negotiation. Enabling the lane reversal can 
help you test the DUT’s capability to perform lane ordering 
during link training.

Lane Polarity Inversion

You can set the Lane Polarity inversion for each lane of the 
link independently. If you select the Polarity inversion for a 
lane, then at the time of link training, the receiver gets an 
indication of the lane polarity inversion setting through the 
transmitted TS1 and TS2 ordered sets. Subsequently, it 
indicates that the receiver must invert the received data. 
Setting the Tx lane polarity inversion can help you assess 
DUT's capabilities to understand and implement polarity 
inversion during the link training. 
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You use the Equalization Settings tab in the General pane to 
configure the Equalization settings for the Protocol Exerciser 
Transmitter (Tx). The settings are configured separately for 
5.0 and 8.0 link speeds. This topic describes how to 
enable/disable and configure the equalization settings.
Figure 9 Equalization settings tab
Transmitter Based Equalization (De-emphasis) for 5.0 GT/s speed
For 5.0 GT/s link speed, you can select the Tx de- emphasis 
option on a per- link basis. You can enable and set the Tx 
de- emphasis level that the Protocol Exerciser will use for 
transmission using the De- emphasis shown in TS listbox in 
the 5.0 groupbox. Typically, the - 3.5dB option is used when 
Protocol Exerciser is acting as a DSC and the - 6dB option is 
used when Protocol Exerciser is acting as a USC.
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42
For 8.0 GT/s, all the operational and associated lanes of a 
link need to participate in the equalization procedure to 
adjust their transmitter and receiver setups to improve 
signal quality when moving to 8.0 GT/s. Each combination of 
Tx, channel, and Rx will have a unique set of coefficients 
yielding an optimum signal- to- noise ratio. The training 
sequences exchanged during the link training to 8.0 GT/s 
consists of negotiating the equalization coefficients to be 
used, to ensure reliable transfer of data. 

For any link training or link speed upgrade to 8.0 GT/s, the 
link partners have to go through the phases of the 
Equalization procedure as per the PCIe specifications. The 
USC and DSC use the following phases to adjust the 
Transmitter and Receiver setup of each lane to improve the 
signal quality. 

• Phase 1 -  Both USC and DSC transmit with the specified 
preset values. The specified FS and LF values are 
advertised in phase 1. 

• Phase 2 -  DSC tunes the USC by requesting a change in 
the coefficients at the transmitter of the USC.

• Phase 3 -  USC tunes the DSC by requesting a change in 
the coefficients at the transmitter of the DSC.

Protocol Exerciser supports two types of equalization when 
moving to 8.0 GT/s. These are described in the following 
sections.
Autonomous equalization
The Autonomous equalization feature is applicable if the link 
partners are 8.0 GT/s capable during the initial link 
negotiations and they are moving to 8.0 GT/s from the 
Detect state. To perform autonomous equalization, Protocol 
Exerciser acting as a USC autonomously transitions from L0 
to Recovery before transmitting any DLLPs. To accomplish 
the autonomous equalization, the Autonomous speed change 
to 8 GT/s option in the Link Settings tab should be 
selected. If this option is not selected, the link is not moved 
to 8.0 GT/s after it gets trained to 2.5 GT/s.

If Autonomous speed change to 8 GT/s option is selected, 
Protocol Exerciser acting as a USC will always perform 
equalization at the first entry to 8GT/s after exit from the 
Detect State. If Protocol Exerciser is acting as a DSC, it will 
respond to the Equalization state transitions of USC.
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The software based equalization feature is applicable if the 
link is configured at 2.5 or 5.0 GT/s and a link partner 
requests to move to 8.0 GT/s with both link partners capable 
of 8.0 GT/s data rate. You can configure Protocol Exerciser 
to enable/disable software based equalization while moving 
to 8.0 GT/s from 2.5 or 5.0 GT/s. 

Enabling Equalization at 8.0 GT/s

If Protocol Exerciser is acting as USC and you want Protocol 
Exerciser to perform software based equalization while 
moving to 8.0 GT/s, ensure that:

• the Perform Equalization in Recovery @8 GT/s option is 
selected in the Equalization settings tab. Protocol 
Exerciser (acting as a USC) then must perform 
Equalization when upgrading the link speed to 8.0 GT/s.  
If this option is not selected, then the link speed upgrade 
to 8.0 GT/s happens without performing equalization.

If Protocol Exerciser acting as a USC is configured to 
perform equalization and you want to ensure that it 
performs all the three phases of equalization, then select the 
Perform Phase 2/Phase 3 option in the Equalization 
settings tab. Protocol Exerciser (acting as a USC) then must 
perform Phase 2 and 3 of Equalization when upgrading the 
link speed to 8.0 GT/s. If this option is not selected, then 
Protocol Exerciser exits the Recovery.Equalization sub- state 
after phase 1 and transitions to the Recovery.RcvrLock 
substate to proceed towards making the link operational at 
the 8.0 GT/s speed.  

If you want to ensure that Protocol Exerciser (acting as a 
DSC) should request the USC to redo the equalization, then 
select the Request Equalization in Recovery @8GT/s option 
in the Equalization settings tab. 

Disabling Equalization at 8.0 GT/s

If you do not want Protocol Exerciser to perform software 
based equalization while moving to 8.0 GT/s, ensure that:

• the Perform Equalization in Recovery @8 GT/s option is 
deselected in the Equalization settings tab. This is  
applicable if Exerciser is used as a USC. 

• the Perform Phase 2/Phase 3 option is deselected in the 
Equalization settings tab. This is applicable if Exerciser 
is used as a USC. 
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If you do not want Protocol Exerciser acting as a DSC to 
request USC to redo equalization while moving to 8.0 GT/s, 
then deselect the Request Equalization in Recovery @8 
GT/s option in the Equalization settings tab. 
Configuring Equalization settings

NOTE Protocol Exerciser needs to perform or respond to the Equalization phases 
while running some LTSSM tests used to test DUT's LTSSM functions. For 
these tests, the Equalization settings that you configured in this tab are 
over-ridden by the equalization settings relevant for the test when the test 
is running. The configured equalization settings are reverted back when 
the test execution is over.

For instance, you have not enabled software based equalization and 
executed the LTSSM test to upgrade the link speed to 8.0 GT/s with 
equalization. In this situation, the test overrides the disabled equalization 
setting and performs equalization while upgrading to 8.0 GT/s. 
You configure the equalization co- efficients, presets, and FS 
and LF voltage swings for the Protocol Exerciser transmitter 
using the Equalization Settings tab in the General 
navigation pane of the Protocol Exerciser GUI. Protocol 
Exerciser uses these settings to perform or respond to the 
Equalization steps while training/retraining, or upgrading the 
link to the 8.0 GT/s link speed.
NOTE Refer to the Protocol Exerciser GUI Reference help topics in this online 
help to get a detailed description of each field in this tab page. 
Alternatively, click the Help button displayed in the tab page to get a 
context-sensitive help page.
Setting Equalization values

You can set the:

• FS and LF values that the Protocol Exerciser advertises 
during the link training for its Tx capabilities using the 
Exerciser group box. 

• Tx De- emphasis preset and co- efficient values that the 
Protocol Exerciser advertises during the link training for 
its Tx capabilities using the Exerciser group box. 

• Tx De- emphasis preset and co- efficient values that the 
Protocol Exerciser will send to DUT in the training 
sequences to request DUT to use the specified presets and 
co- efficient values using the Request to DUT group box. 
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NOTE Protocol Exerciser ignores all the Tx De-emphasis value requests from 
DUT.  To yield an optimum combination of Tx/Rx equalization, it uses the 
Protocol Exerciser Tx and Rx equalization settings that you set in the 
Transceiver settings tab. 
NOTE In comparison to a standard PCIe device, Protocol Exerciser can also 
control the electrical de-emphasis settings that are independent of the 
settings in the training sequences. This allows you to test the 
de-emphasis level negotiation protocol without changing the electrical 
behavior of Protocol Exerciser.
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You can set the Protocol Exerciser Transmitter and Receiver 
equalization settings using the Transceiver Settings tab. 
These settings impact the overall signal quality. You should 
change the default settings in this page if you are facing 
problems specific to signal quality or you want to test how 
the changes in these settings impact the overall signal 
quality.

You can adjust the transceiver settings to yield an optimum 
combination of Tx/Rx equalization. 

Using the Transceiver Settings tab, you can adjust the output 
voltage, pre tap, first post tap, and second post tap for the 
Protocol Exerciser transmitter and the AC and DC Gain 
settings for the Protocol Exerciser Receiver.

The following figure displays the default Transceiver settings.
Figure 10 Transceiver Settings tab

Refer to the Protocol Exerciser GUI Reference help topics in this online 
NOTE
help to get a detailed description of each field in this tab page. 
Alternatively, click the Help button displayed in the tab page to get a 
context-sensitive help page.
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Protocol Exerciser can generate events or trigger other test 
equipments such as logic analyzers or protocol analyzers 
when a specified trigger condition is met. You can set the 
trigger conditions using the Trigger Out tab. Once you enable 
the trigger out conditions, Protocol Exerciser records and 
displays a corresponding event generating a trigger out pulse 
when any of these conditions are met. The external trigger 
out pulse is generated at 125 ns. The list of accumulated 
events is displayed in the Trigger Out tab.

The following trigger out conditions are available:

• Protocol Error -  An event is generated on encountering 
any protocol related error.

• Going Out of L0 -  When the LTSSM state transitions out 
of L0 indicating that the link is not operational, Protocol 
Exerciser alerts you by generating an event. 

The U4305A exerciser card has a component, namely Trigger 
Out Connector, located on the front bracket of the card. This 
component is used to generate a trigger out pulse from 
Protocol Exerciser to other test equipment. 
NOTE Refer to the Protocol Exerciser GUI Reference help topics in this online 
help to get a detailed description of each field in this tab page. 
Alternatively, click the Help button displayed in the tab page to get a 
context-sensitive help page.
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Initializing and training a PCIe Link between Protocol Exerciser and 
DUT    50

Retraining a PCIe Link between Protocol Exerciser and DUT    53

Initiating Link Speed Change on a Configured Link    54

This chapter describes how to initialize and train a PCIe link 
and how to manage it in terms of retraining it and 
upgrading or downgrading the link speed.

 

49Agilent Technologies



4 Initializing and Managing a PCIe Link
Initializing and training a PCIe Link between Protocol Exerciser and DUT
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Before you can start using Protocol Exerciser to stimulate 
DUT with PCIe traffic or to test DUT's LTSSM functions like 
speed changes, you need to initialize the PCIe link between 
Protocol Exerciser and DUT. 

The Hardware Status pane in the Protocol Exerciser GUI 
displays the current status of the link. Before initializing the 
link, the status is reflected as No Link indicating that the 
link is not operational. 

Before you start:

• Make sure you have configured the link, lane, and other 
settings relevant for link training in a Protocol Exerciser 
Setup file. You use the General navigation window of the 
Protocol Exerciser GUI to configure these settings. Refer 
to the chapter Configuring Protocol Exerciser to know 
more.

• If you want Protocol Exerciser to initialize and train the 
link to 8.0 GT/s autonomously, then ensure that the data 
rate capability of both the link partners is 8.0 GT/s and 
you have selected the Autonomous speed change to 8 
GT/s check box in the Link Settings page. If this check 
box is not selected, Protocol Exerciser does not 
autonomously move the link to the 8 GT/s speed and 
trains it to 2.5 GT/s. You can then later upgrade the 
speed to 8.0 GT/s through the Initiate Speed Change 
menu option. 
Training a PCIe Link
To create/initialize a PCIe link, click the  icon on the 
toolbar. Alternatively, you can also select the Action > Link 
Up menu command. This creates a link between the current 
Protocol Exerciser session and DUT.  The link is trained to 
2.5 GT/s even if the link partners advertise a higher data 
rate capability during link training. However, if the data rate 
capability of both the link partners is 8.0 GT/s and you have 
selected the Autonomous Speed change to 8 GT/s check 
box in the Link Settings page, the link is trained to 8 GT/s.  
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You can check the status of the link training action using the 
Hardware Status pane of the Protocol Exerciser GUI. The 
following screens displays the status of the link before and 
after the link up.

You can check the status of the link training action using the 
Hardware Status pane of the Protocol Exerciser GUI. The 
following screens displays the status of the link before and 
after the link up.

Figure 11 Protocol Exerciser - Hardware Status Before Link Up
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Figure 12 Protocol Exerciser - Hardware Status After Link Up
NOTE If you are trying to configure an exerciser card of higher link width (such as 
x8) to a lower link width (such as x1), then you may face the following 
issue:

As the receivers of the exerciser card have the 50 OHm termination 
resistance, the receiver detect logic of the system detects 8 receivers. If 
during linkup, the system does not get a valid signal on all the lanes where 
it detected a receiver, the system according to the specification goes into 
the compliance mode. 

This issue can only be worked around by taping off unused lanes, or by 
using a passive slot-interposer with a smaller edge connector according to 
the desired link width.
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Once you have initialized the PCIe link between Protocol 
Exerciser and DUT, you can start using Protocol Exerciser. 
As you progress with the DUT testing, you may need to 
retrain this link between DUT and Protocol Exerciser, for 
instance, in case of link errors or if during an LTSSM test 
execution, the advertised or received data rate do not match 
the data rate capabilities. 

Consider a situation when you have changed the speed of a 
configured link from 5.0 GT/s to 2.5 GT/s. Consequently, the 
advertised data rate is also reflected as 2.5 GT/s. You can 
then retrain the link to ensure that the advertised and 
received data rate are restored back to the set 2.5 and 5.0 
GT/s capabilities. 

To retrain a PCIe link, click the  icon on the toolbar. 
Alternatively, you can also select the Action > Initiate 
Retrain Link menu command. 

Protocol Exerciser then retrains the link by moving it to 
recovery and then back to the Operational state. The link is 
retrained/recovered as per the link and lane settings 
negotiated during the initial link training sequence. For 
example, the link is trained to 2.5 GT/s and the data rate 
capabilities of DUT and Protocol Exerciser are 5.0 GT/s. By 
initiating the link retraining, the initial data rate – 2.5 GT/s 
is used to retrain the link. The Advertised and Received data 
rate capabilities are updated based on the current data rate 
capabilities of the link partners.  

You can verify if the link is retrained successfully by viewing 
the status of the link in the Hardware Status pane of the 
Protocol Exerciser GUI. On the successful retraining, the link 
status should be Active and the link speed, link width, 
advertised and received data rate and lane polarity reversal 
are as per the initial link and lane negotiations. 
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As you progress with the DUT testing on a configured link, 
you may need to change the link speed to test the DUT's 
capabilities in a higher/lower speed scenarios.

To change the link speed on a configured link, click the  
icon on the toolbar. Alternatively, you can also select the 
Action > Initiate Speed Change menu command. 

Protocol Exerciser then initiates link speed change to the 
highest data rate advertised by both the link partners during 
link training. 

If the link is already at the highest data rate supported by 
both the link partners and you want to downgrade the link 
speed, then you first need to downgrade the data rate 
capabilities of a link partner before starting speed change. In 
such a situation, the link speed is downgraded based on the 
changed data rate capability.

You can verify if the link speed has been changed 
successfully by viewing the status of the link speed in the 
Hardware Status pane of the Protocol Exerciser GUI. 
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LTSSM    56

LTSSM Tester - Introduction    58

When to Use LTSSM Tester    60

How LTSSM Tester Works    62

Getting Started with LTSSM Tester    65

Testing Link Initialization, Training, and Management    68

This chapter provides detailed information on Protocol 
Exerciser's use as an LTSSM to test a DUT's LTSSM 
functions. This chapter describes Protocol Exerciser's test 
tool -  LTSSM Tester and how to use it to perform LTSSM 
testing.
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Link Training and Status State Machine (LTSSM) is the 
sub- block that drives and controls the link initialization, and 
training process for a PCIe device to enable the normal data 
exchange between the two devices over the link. LTSSM 
operates at the physical layer level and exchanges physical 
layer packets (Ordered sets such as TS1 and TS2) to 
initialize, train, and manage the link.
LTSSM Functions
The following are some of the key functions of LTSSM that 
are referred to later in this chapter in the context of LTSSM 
testing. 

• Link initialization and configuration to bring the link to 
an operational state when TLP and DLLPs can be 
transmitted over it. 

• Link recovery or retraining in situations such as speed 
changes,  power management, or recovering from a link 
error.

• Performing link bandwidth management by downgrading 
or upgrading the link speed in response to a link speed 
change request.

• For PCIe Gen3 devices, performing the Equalization 
procedure before reaching the Gen3 (8.0 GT/s) speed 
during the link training or retraining.
LTSSM States
LTSSM transits through various states and substates during 
link initialization, training, and management. The entry and 
exit of each of these states and the exchange of packets 
(Ordered sets) between the two devices during each state is 
as per the PCIe specifications.

As per the PCIe specifications, LTSSM has 11 states and 
further substates. These states are referred to frequently in 
this chapter to describe LTSSM testing using the Agilent 
LTSSM Tester tool. Following is a list of these states followed 
by a diagram to illustrate the sequence of these states as per 
the PCIe specifications.

• Detect 

• Quiet 
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• Polling 

• Configuration 

• L0 

• Recovery 

• L0s 

• L1 

• L2 

• Hot Reset 

• Disabled 

• Loopback 

The following figure displays the top- level states of LTSSM.

Figure 13 LTSSM States
NOTE For information on different LTSSM states and sub-states, refer to PCI 
Express specification.
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LTSSM Tester - Introduction
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LTSSM is one of the key challenges when moving from PCI 
Express Gen2 to Gen3 with link testing for Gen3 as one of 
the biggest validation challenges. 

Agilent LTSSM Tester is a tool that helps you perform link 
negotiations testing effectively and thoroughly to test a 
DUT’s LTSSM functions. Using this tool, you can verify all 
the LTSSM state transitions of DUT and check if all the state 
timeouts are correctly implemented. This tool provides you a 
set of predefined LTSSM tests to help you assess if the 
DUT’s LTSSM capabilities are as per the LTSSM rules 
specified in the PCIe specifications. 

The LTSSM Tester tool is integrated with Protocol Exerciser 
and is available as a tab in the Protocol Exerciser GUI. 
When you install and configure the Agilent’s Protocol 
Exerciser card, the card emulates a PCIe device and provide 
the LTSSM functionality as well to stimulate the DUT’s 
LTSSM functions.

Protocol Exerciser exchanges appropriate physical layer 
packets (ordered sets) with the DUT as per the PCIe 
specifications to test DUT’s LTSSM capabilities. You can 
access the LTSSM functions provided by Protocol Exerciser 
by running the appropriate LTSSM tests using the LTSSM 
Tester tool. The test results help you assess the DUT’s 
capabilities in the context of a particular LTSSM function.
Protocol Exerciser as a USC and a DSC in context of LTSSM testing
Protocol Exerciser can act as an Upstream Component (USC) 
or a Downstream Component (DSC) with DUT for LTSSM 
testing. Protocol Exerciser functions as a USC or a DSC 
depending on the session type that you selected based on 
the Exerciser card setup. You use the Link Settings page of 
the General tab of the Protocol Exerciser GUI to select the 
session type.

As a USC, Protocol Exerciser emulates a root complex and 
controls the link initialization, training, and management 
sequences for self- initiated or DUT initiated requests. DUT, 
in this case, acts as a DSC and responds to the sequences. 

As a DSC, Protocol Exerciser emulates an end point and 
only responds to the LTSSM function sequences performed 
by the DUT acting as a USC in this case.
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The LTSSM Tester tool provides various features that make it 
a useful tool to perform the DUT’s LTSSM testing. Some of 
the key features of LTSSM Tester are listed below.

• Can explicitly test or force LTSSM state transitions. 

• Can monitor state transitions and follow timeout 
controlled process to ensure protocol compliance.

• Supports scalable speed transitions varying from 2.5 GT/s 
to 8.0 GT/s.

• Supports LTSSM testing for Gen1, Gen2, and Gen3 PCIe 
devices.

• Supports lane polarity inversion setting for all the lanes 
independently. 

• Supports link widths ranging from x1, x4, x8 to x16 (any 
combinations allowed). X2 is not supported.

• Supports automatic or manual enabling /disabling of the 
lane reversal feature to help you test the DUT’s lane 
reversal feature.

• Supports data scrambling settings.

• Can test link initialization and retraining with or without 
performing the Equalization procedure.

• Captures and displays the LTSSM state transitions along 
with the timestamps for:

• fast and easy debug and 

• verification to ensure that DUT's LTSSM state 
transitions and timeouts are as per the PCIe 
specifications. 

• Can initiate link transition to recovery.

• Can create corner conditions to test DUT's error 
responses.

• Supports Equalization Settings to improve signal quality 
for DUT and Exerciser.

• Supports Transceiver Settings for hardware connected for 
variable voltages.

• Supports displaying the protocol errors violated while 
linking, retraining, recovering or speed change.
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LTSSM Tester provides a set of LTSSM tests to help you test 
various aspects of DUT’s LTSSM. The following list provides 
you pointers to the broad areas/situations when these tests 
can help you in LTSSM testing.

To test and assess if:

• The DUT is able to perform or respond to the link 
initialization and training process at the negotiated link 
speed and width.

• The DUT’s LTSSM state transitions are as per the LTSSM 
rules specified in the PCIe specifications.

• The DUT’s LTSSM transits to recovery and back to the 
operational state for a link retraining request (for 
instance, link errors or link speed changes).

• The DUT can successfully transit from Gen2 to Gen3 in 
terms of higher link speeds, new training sequences for 
the equalization procedure, and other PCIe specifications 
which are new for Gen3. 

• The DUT autonomously changes the link speed to 8.0 
GT/s after initiating the link to 2.5 GT/s while performing 
the Equalization procedure.

• The DUT can perform a downgrade or an upgrade link 
speed in response to a self initiated or a link partner 
initiated speed change request on a configured link. This 
can help you assess how well the DUT handles link 
bandwidth management.

• The DUT can handle link and lane settings negotiated 
during the link training process and can successfully train 
the link with these negotiated or discovered settings. For 
instance, lane polarity inversion is selected and advertised 
during the link training. You can test if the DUT‘s LTSSM 
initializes the link with lane polarity inversion.
LTSSM Supported States
LTSSM has 11 states with further substates. LTSSM transits 
through these states while performing the link initialization, 
training, and management.

In this release, LTSSM Tester supports the LTSSM states 
transitions except the following states or a state feature:

• Multi- link configuration
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• Polling compliance testing

• Link power management states

• Direct to Hot Reset or Disabled state

• Loopback
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This topic describes the overall working of the LTSSM Tester. 

All the LTSSM tests are available in the LTSSM Tests tab of 
the Protocol Exerciser GUI. When a user runs an LTSSM 
test, the LTSSM Tester tool executes that test’s steps taking 
all the required link, lane, equalization, and other settings as 
inputs. The test execution and observations depend on 
whether the Protocol Exerciser is acting as a USC or a DSC 
(based on the user- configured session type).  Most of the 
tests have some prerequisites that need to be fulfilled. 
LTSSM Tester checks if the test prerequisites are met 
without which the test execution fails.

When LTSSM Tester starts executing the test, appropriate 
ordered sets are exchanged between the Protocol Exerciser 
and DUT as per the PCIe specifications. During the test 
execution, Protocol Exerciser transits through various 
applicable LTSSM states and forces the DUT to make the 
changes to its LTSSM states so that you can verify the state 
transitions. By looking at the responses from the DUT, 
Protocol Exerciser checks if the DUT has taken the correct 
arcs in the state- machine and made the correct transitions 
or not.  LTSSM Tester captures and displays the state 
transitions in a test log to help you identify the source of 
problem (if any) and debug when the test stops.

As a USC, Protocol Exerciser performs all the necessary 
steps of the LTSSM function for which the test is executed. 
As a DSC, it responds to the steps of the LTSSM functions 
that DUT performs for that test.

When the test execution completes, LTSSM Tester updates 
the status of the link, lane, and other relevant settings that 
are impacted by the test execution. These updates are 
displayed in the Hardware Status window of the Protocol 
Exerciser GUI. The test result and the applicable LTSSM 
state transitions (expected and actual) are displayed in the 
test log pane of the GUI. If an actual state transition is 
different from the expected state transition, the test fails 
notifying the user about the state at which it failed. LTSSM 
Tester also displays the timestamp for each state transition 
to indicate the time taken to transit from one state to 
another.

The following diagram illustrates the working of LTSSM 
Tester.
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Figure 14 How LTSSM Tester Works

Consider an example of an LTSSM test to initialize and train 
the link to 2.5 GT/s with Protocol Exerciser acting as a USC 
and DUT as a DSC.

When you execute the Link training test, LTSSM Tester 
checks the data rate capability of the Protocol Exerciser, 
selected link width, lane settings, and other relevant settings. 
Protocol Exerciser then starts performing the link training 
sequence. It exchanges training sequences with DUT to 
negotiate link parameters such as link speed, link width, 
lane polarity, link number, and scrambler enabled or 
disabled. Protocol Exerciser trains the link initially to 2.5 
GT/s even if the link partners (Protocol Exerciser and DUT) 
are capable of transmitting at higher data rates. When the 
test execution completes, the link status (No link or Active), 
negotiated link speed and advertised and received data rate 
capabilities of Protocol Exerciser and DUT respectively are 
displayed in the Hardware Status window of the Protocol 
Exerciser GUI. Once the link is trained to 2.5 GT/s, the 
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LTSSM state transitions to L0 indicating that the link is 
operational. After this, Protocol Exerciser handles any 
upgrade to speed by retraining the link as a response to a 
self- initiated or DUT initiated speed change request. The 
following screen displays a sample test log generated for 
such a test with all the LTSSM state transitions while 
initiating the link to 2.5 GT/s.
Figure 15 Sample LTSSM test log
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LTSSM Tester is integrated with Protocol Exerciser and all 
LTSSM functions are available as a tab in the Protocol 
Exerciser GUI.
Accessing LTSSM Tester
You can access LTSSM Tester from the Navigation window of 
the Protocol Exerciser GUI.

To access LTSSM Tester

1 Start the Protocol Exerciser GUI. For information on 
starting the Protocol Exerciser GUI, refer to Starting and 
Exiting the Protocol Exerciser GUI on page 26.

2 Click the LTSSM Test icon in the Navigation window.

The LTSSM Test screen is displayed in the main Protocol 
Exerciser window.
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Figure 16 LTSSM Test screen

In this release, except for the following icons, all other icons are disabled 
NOTE
in the Navigation window of the Protocol Exerciser GUI:

- General 

- LTSSM Test 

- Protocol Checker
All the supported LTSSM tests are grouped under the LTSSM 
Tests listbox. On clicking a test, its description and sequence 
of execution steps are displayed in the Description and 
Sequence panes respectively. 
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The Log pane provides you details of the steps that the 
LTSSM Tester is performing during the test execution. It 
displays the prerequisites that are checked, the steps that 
are performed, and the LTSSM states that the LTSSM 
Exerciser transits during the test execution. Based on 
whether all the test prerequisites are met and whether all 
the LTSSM state transitions are as expected, the Log pane 
displays test result as Success or Failure.
Prerequisites for LTSSM Testing

NOTE Refer to the Protocol Exerciser GUI Reference help topics in this user guide 
to get a detailed description of each field in the LTSSM Test page. 
Alternatively, click the Help button displayed in the tab page to get a 
context-sensitive help page.
• Ensure that all the test specific prerequisites are met 
before executing the test. Each test has some 
prerequisites which are listed in the LTSSM Tests pane.

• Ensure that all the link and lane settings are configured 
using the General tab of the Protocol Exerciser GUI. 
Protocol Exerciser uses these settings for link negotiations 
during the link training sequence. 

• Ensure that the Equalization and Transceiver settings 
(coefficients and presets) are appropriately configured for 
tests that perform or respond to the equalization 
procedure.

• Ensure that the DUT is connected to the Protocol 
Exerciser.
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Testing Link Initialization, Training, and Management

LTSSM Tests
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LTSSM Tester provides a set of predefined LTSSM tests that 
you can run from the LTSSM Test tab of the Protocol 
Exerciser GUI. 

To run a test, click the icon. Before running a test, 
check if all the test prerequisites stated in the Prerequisites 
section of the test are met.

Sequence of Steps in LTSSM Tests

1 For an LTSSM test, LTSSM Tester first checks the test 
prerequisites. 

2 If all prerequisites are met, the training sequence is 
started and LTSSM state transitions are captured, checked 
and displayed. 

3 If an LTSSM state transition is not as per the PCIe 
specifications, the test stops and fails. 

4 The test result is displayed along with the reason for the 
test failure if the test failed.

Understanding the Test Results 

The test results are displayed in the Log pane of the LTSSM 
Tests window. A test Log helps to identify the root cause of 
a problem. For instance, the test log shows test failure due 
to an unexpected LTSSM state change (RecRvcfg was 
expected but RecSpeed transition happened). This pane 
displays the following information with the date and time 
stamp:

• Name of the executed test.

• The list of prerequisites that are being checked for the 
test execution.

• The status of the "Check prerequisites" step. It displays 
Success if all the prerequisites are met and displays 
Failed if one or more prerequisites are not met causing 
the test to fail.

• The LTSSM states through which Protocol Exerciser 
transits during the test execution. If any of the LTSSM 
state transitions is missing or is not the expected state 
transition specified in the PCIe specifications, the test 
fails stating the LTSSM state which caused the test to fail.
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• The test case result based on whether or not all 
prerequisites are met and all the LTSSM state transitions 
are as per the expected state transitions in PCIe 
specifications. It displays Success, Failure, or Cancelled by 
user. It also displays the outcome of the test in terms of 
the current link speed, link width and link status. 

You can save the test results as an RTF or a TXT file by 
right- clicking anywhere inside the Log pane and clicking 
Save as...

In this release, the following LTSSM tests are provided. Click 
a test to get a detailed description of its usage, flow, and 
test results.

Basic Tests

• Exerciser starts Link Training to 2.5 GT/s on page 69

• Exerciser starts Link Training to 2.5 GT/s on page 69

• Exerciser Initiates Transition to Recovery Test on page 80

• Exerciser starts Link Training to 2.5 GT/s on page 69

Link Speed Upgrade tests

• Exerciser starts Link Training to 2.5 GT/s on page 69

• Exerciser starts Link Training to 2.5 GT/s on page 69

Link Speed Downgrade Tests

• Exerciser starts Link Training to 2.5 GT/s on page 69

• Exerciser starts Link Training to 2.5 GT/s on page 69
Testing Link Training
Exerciser starts Link Training to 2.5 GT/s

Description

This test initializes and trains the PCIe link between the 
Protocol Exerciser and DUT to 2.5 GT/s. Even if the data 
rate capabilities of both the link partners is higher, the test 
trains the link to 2.5 GT/s. However, the link speed can later 
be upgraded by running a link speed change LTSSM test. 

In this test, Protocol Exerciser performs link training and 
exchanges training sequences with DUT to negotiate link 
parameters like: 

• lane polarity 

• link number
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• set of lanes that belong to the link

• lane numbers

• scrambler enabled or disabled

• link speed

• number of fast training sequences required

Usage

• You can use this test to check if the DUT’s LTSSM can 
initialize the link to 2.5 GT/s. This is the basic test to test 
the linkup between Protocol Exerciser and DUT. You can 
use this test as the initial test to test other scenarios 
such as link transition to recovery and autonomous or 
manual speed changes after the link initializes to 2.5 
GT/s.

• This test also lets you check whether DUT initializes the 
link with the user- configured link and lane settings such 
as lane polarity inversion or lane reversal negotiated 
during the training sequence. You can test if the DUT can 
understand and implement polarity inversion for lanes if 
you selected this option for lanes.

Test Results

If the test passes, the LTSSM state is L0 indicating that the 
link is up and operational. The link status is displayed as 
Active in the Hardware Status window to indicate the 
successful link up. 

If the test fails, it indicates:

• Link is not up.

• Link or lane settings incompatibility on either of the two 
link partners side. For instance, Polarity inversion set for 
the Transmitter of the Protocol Exerciser but not 
implemented on DUT or data scrambling enabled at USC 
but not at DSC.

• Missing or unexpected LTSSM state transitions. For 
instance, the test log shows test failure when the LTSSM 
state does not transit to Configuration.Linkwidth.Start 
after Polling.Configuration while running the link training 
test.

Exerciser starts Link Training to 8.0 GT/s with Equalization Tests

LTSSM Tester provides the following two tests to train the 
link to the 8.0 GT/s speed with the execution of the 
Equalization procedure. 
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• Link training to 8.0 GT/s with the execution of all the 
phases of Equalization

• Link training to 8.0 GT/s with only the first phase of 
Equalization

Both these tests are described below with a focus on the 
difference in their Equalization execution.

Link training to 8.0 GT/s with all the phases of 
Equalization test

Description

This test initializes and trains the PCIe link between the 
LTSSM Exerciser and DUT to 2.5 GT/s initially. If the data 
rate capabilities of both the link partners is advertised as 
8.0 GT/s, the test initiates the transition to the 
Recovery.Equalization sub state to perform all the phases of 
the Equalization procedure before moving the link to 8.0 
GT/s. While performing equalization, Protocol Exerciser 
advertises the Equalization settings (presets, coefficients, and 
voltage swings) that you specified in the Equalization 
Settings page as its Tx capabilities for the transmission of 
training sequences. In phase 2 and 3, DUT and Exerciser 
tune the equalization settings by requesting a change in the 
coefficients at the transmitter of the link partner. Protocol 
Exerciser uses the equalization settings specified in the 
Equalization Settings page to perform or respond to these 
phases. If the Equalization phases are successfully done, 
then both Protocol Exerciser and DUT transition to the  
Recovery.RcvrLock sub state to proceed towards making the 
link operational at the 8.0 GT/s speed.  

Usage

• You can use this test to check the full execution of the 
equalization procedure with DUT acting as a USC or a 
DSC. 

• You can verify the Equalization substates entered after 
reaching to 2.5 GT/s and before achieving 8.0 GT/s. 

• You can use this test to troubleshoot at which phase of 
equalization, the problem occurs.

Test Flow

This section displays the sequence of test execution in terms 
of the LTSSM state transitions and the steps performed by 
DUT and Protocol Exerciser during the test execution.
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The following figure displays the test flow during the 
Equalization phases when Exerciser acting as a USC has 
trained the link to 2.5 GT/s and moved to the 
Recovery.Equalization substate to perform all the phases of 
equalization before moving the link to 8 GT/s.
Test Results

If the test passes, the LTSSM state is L0 indicating that the 
link is up and operational at 8.0 GT/s. The link status is 
displayed as Active in the Hardware Status window to 
indicate successful link up. 

If the test fails, it indicates:

• One or more of the test prerequisites are not met.

• Link or lane settings incompatibility on either of the two 
link partners side. For instance, Polarity inversion set for 
the Transmitter of the Protocol Exerciser but not 
implemented on DUT.

• Failure of transition to correct Equalization substates 
while performing Equalization.

• Inappropriate Equalization settings.
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You can try fine tuning the Tx De- emphasis values for the 
Protocol Exerciser and the DUT using the Equalization 
Settings tab. 

Link training to 8.0 GT/s with the first phase of 
Equalization test

Description

This test initializes and trains the PCIe link between the 
Protocol Exerciser and DUT to 2.5 GT/s initially. If the data 
rate capabilities of both the link partners is advertised as 
8.0 GT/s, the test initiates the transition to Recovery to 
perform the first phase of the Equalization procedure before 
achieving 8.0 GT/s. During link training, the first phase 
requires both USC and DSC to advertise the preset values. 
Protocol Exerciser advertises the Equalization settings 
(presets, co- efficients, and voltage swings) that you specified 
in the Equalization Settings page as its Tx capabilities for 
the transmission of training sequences. USC exits the 
Recovery.Equalization sub- state after phase 1 and transitions 
to the Recovery.RcvrLock substate to proceed towards 
making the link operational at the 8.0 GT/s speed.  

Usage

• You can use this test to check if the DUT’s LTSSM can 
initialize the link to 8.0 GT/s with the execution of phase 
1 of equalization. 

• You can verify the Equalization substates entered after 
reaching to 2.5 GT/s and before achieving 8.0 GT/s. 

• You can use this test to troubleshoot whether or not the 
device is capable of undergoing the first phase of 
equalization while achieving 8.0 GT/s.

Test Results

If the test passes, the LTSSM state is L0 and link speed is 
8.0 GT/s indicating that the link is up and operational at 8.0 
GT/s. The link status is displayed as Active in the Hardware 
Status window to indicate successful link up. 

If the test fails, it indicates:

• One or more of the test prerequisites are not met.

• Link or lane settings incompatibility on either of the two 
link partners side. For instance, Polarity inversion set for 
the Transmitter of the Protocol Exerciser but not 
implemented on DUT.
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• Failure of transition to correct LTSSM states while 
performing Equalization.

• Inappropriate Equalization settings.

You can try fine tuning the Tx De- emphasis values for the 
Protocol Exerciser and DUT using the Equalization Settings 
tab. 
Testing Link Speed Changes
Link Speed Change Without Equalization Tests

This topic describes the LTSSM tests that you can use to test 
the DUT’s LTSSM function of performing or responding to 
link speed changes on a configured link. In these tests, 
Equalization is not performed when moving to the 8.0 GT/s 
speed from 2.5 GT/s or 5.0 GT/s. The tests transitions the 
LTSSM of link partners to Recovery and then back to the 
operation state at the new speed. 

Before executing a link speed change test:

• ensure that the Protocol Exerciser's data rate capabilities 
are appropriately set to support the desired link speed. 
You set data rate capabilities using the Link Settings page 
of the General icon in the Protocol Exerciser GUI. If one 
of the link partners does not support the desired link 
speed, then the test fails stating that the prerequisites is 
not met. 
NOTE For link speed change to 8.0 GT/s tests, the Equalization options that you 
enabled/disabled in the Equalization Settings tab are over-ridden by the 
equalization options relevant for the test when the test is running. 
However, the equalization options that you set are reverted back when the 
test execution is over. 

For instance, you have not deselected the Perform Equalization in 
recovery @ 8 GT/s option in the Equalization Settings tab and executed 
the LTSSM test to upgrade the link speed to 8.0 GT/s without equalization. 
In this situation, the test overrides the enabled equalization setting and 
skips equalization while upgrading to 8.0 GT/s.
Description
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Once the link is up between the Protocol Exerciser and DUT, 
you can use various link speed change tests available in the 
LTSSM Tester to upgrade the link speed or later downgrade 
it for link bandwidth management testing.

These tests are categorized into:

• Link upgrade speed tests – The tests support the 
following speed upgrades:

• 2.5 to 5.0

• 5.0 to 8.0 without Equalization

• 2.5 to 8.0 without Equalization

• Link downgrade speed tests – The tests support the 
following speed downgrades:

• 8.0 to 5.0

• 5.0 to 2.5

• 8.0 to 2.5

These tests are further categorized on the basis of the link 
partner (Protocol Exerciser or DUT) from where you want to 
initiate the link speed change request. Once the request is 
initiated, based on whether the Protocol Exerciser is acting 
as a USC or a DSC for the session, it performs or responds 
to these link speed change requests during the test 
execution. 
NOTE If you want to test a link speed change request initiated by DUT, then you 
manually need to change the link speed at the DUT end on receiving 
instructions during the test execution.
Using these tests, you can also test the implementation of 
the autonomous speed change while changing the link speed 
to 8.0 GT/s on a configured link.

Usage

You can use the link speed change tests to assess:

• DUT’s capabilities to perform or respond to link 
bandwidth management requests.

• DUT’s capabilities to upgrade to 8.0 GT/s without the 
equalization procedure on a configured link. 

• The interconnect data rate as a result of the link speed 
changes and data rate capabilities of link partners.
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• The LTSSM state transitions are as per the PCIe 
specifications.  For instance, LTSSM state transitions to 
all the appropriate substates of Recovery before making 
the link operational at the desired speed change. 

• Whether or not DUT enters the Equalization substates 
before moving the link speed to 8.0 GT/s. 

Test Flow

This section displays the sequence of the test execution in 
terms of the LTSSM state transitions and the steps 
performed by DUT and LTSSM Exerciser during the test 
execution.

The following figure displays the test flow when Exerciser 
initiates the request to upgrade the link speed from 2.5 to 
5.0 GT/s with LTSSM Exerciser acting as a USC.
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Test Result

If the link speed change test passes, the link is operational 
and trained to the new (desired speed). 

If the test fails, it indicates:

• One or more of the listed test prerequisites failed.

• Data rate incompatibility. Either of the two link partners 
does not support the desired link speed. 

• Missing or unexpected LTSSM state transitions. For 
instance, the test log shows test failure for an upgrade 
speed test when the LTSSM state transits to Rec.Speed 
instead of the expected Rec.RcvrCfg after Rec.RcvrLock.

• Transition to Equalization substate(s) by a link partner 
for a speed upgrade to 8.0 GT/s. 
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Link Speed Change With Equalization Tests

This topic describes the LTSSM tests that you can use to test 
the DUT’s LTSSM function of performing or responding to 
link speed change to 8.0 GT/s on a configured link. In these 
tests, equalization is performed before moving to the 8.0 
GT/s speed. You can choose a test based on whether you 
want the test to perform only phase 1 or all the phases of 
equalization. 

In phase 1 of equalization, both DUT and Protocol Exerciser 
advertise their equalization preset values. In phase 2 and 3, 
DUT and Exerciser tune the equalization settings by 
requesting a change in the coefficients at the transmitter of 
the link partner. Protocol Exerciser uses the equalization 
settings specified in the Equalization Settings page to 
perform or respond to these phases.

Either DUT or Exerciser can initiate these tests for a link 
configured to 2.5 GT/s or 5.0 GT/s. Based on whether the 
Protocol Exerciser is acting as a USC or a DSC for the 
session, it performs or responds to these link speed change 
requests during the test execution. 

Before executing a link speed change test:

• ensure that the Protocol Exerciser's data rate capabilities 
are set to support the desired link speed, 8.0 GT/s. You 
set data rate capabilities using the Link Settings page of 
the General icon in the Protocol Exerciser GUI. If one of 
the link partners does not support the 8.0 GT/s link 
speed, then the test fails stating that the prerequisites are 
not met.

• ensure that the preset, co- efficient, and 
minimum/maximum voltage swing values are set for the 
Protocol Exerciser transmitter part. Also, the equalization 
setting values that the Protocol exerciser sends to DUT as 
a request to use these settings to tune the equalization 
should be set. You use the Equalization settings page to 
configure these settings.
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NOTE For these tests, the Equalization options that you enabled/disabled in the 
Equalization tab are over-ridden by the equalization options relevant for 
the test when the test is running. However, the equalization options that 
you set are reverted back when the test execution is over. 

For instance, you have not enabled the Perform Equalization in recovery 
@ 8 GT/s option in the Equalization Settings tab and executed the LTSSM 
test to upgrade the link speed to 8.0 GT/s with equalization. In this 
situation, the test overrides the disabled equalization setting and performs 
equalization while upgrading to 8.0 GT/s. 
Description

Once the link is up between the Protocol Exerciser and DUT, 
you can use various link speed change tests available in the 
LTSSM Tester to upgrade the link speed to 8.0 GT/s to 
specifically test the Gen3 speed bandwidth management.

The tests support the following speed upgrades:

• 5.0 to 8.0 with phase 1 or all phases of equalization

• 2.5 to 8.0 with phase 1 or all phases of equalization

These tests are further categorized on the basis of the link 
partner (Protocol Exerciser or DUT) from where you want to 
initiate the link speed change request. Once the request is 
initiated, based on whether the Protocol Exerciser is acting 
as a USC or a DSC for the session, it performs or responds 
to these link speed change requests during the test 
execution. 
NOTE If you want to test a link speed change request initiated by DUT, then you 
manually need to change the link speed at the DUT end on receiving 
instructions during the test execution.
Using these tests, you can test the implementation of the 
Equalization procedure while changing the link speed to 8.0 
GT/s on a configured link.

Usage

You can use the link speed change tests to assess:

• DUT’s capabilities to perform or respond to link 
bandwidth management requests.

• DUT’s capabilities to implement the Equalization 
procedure while upgrading to 8.0 GT/s.
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• The interconnect data rate as a result of the link speed 
changes and data rate capabilities of link partners.

• The equalization related LTSSM state transitions are as 
per the PCIe specifications.

Test Result

If the link speed change test passes, the link is operational 
and trained to the new (desired speed). 

If the test fails, it indicates:

• One or more of the listed test prerequisites failed

• Either of the two link partners does not support the 8.0 
GT/s link speed. 

• Missing or unexpected LTSSM state transitions. For 
instance, absence of transition to Equalization substates 
while moving to the 8.0 GT/s speed.
Testing Link Retraining and Recovery
Exerciser Initiates Transition to Recovery Test

Description

This test allows you to direct the LTSSM Tester to initiate 
the link retraining or recovery by transiting to the Recovery 
LTSSM state and then back to the Operational state. 

When the test initiates link retraining/recovery, the link is 
retrained/recovered as per the link and lane settings 
negotiated during the initial link training sequence. For 
example, the link is trained to 2.5 GT/s and the data rate 
capabilities of DUT and Protocol Exerciser are 5.0 GT/s. By 
initiating the transition to Recovery, the negotiated data rate 
– 2.5 GT/s is used to recover and retrain the link. The 
Advertised and Received data rate capabilities are updated 
based on the current data rate capabilities of the link 
partners. 

Usage

You can use this test to check: 

• DUT’s capabilities to respond to the transition to the 
Recovery state, in situations such as link errors.

• If the link is retrained/recovered as per the link and lane 
negotiations in the initial training sequence in response to 
an initiation of the transition to recovery.
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Test Results

The test passes if the link transitions to recovery and then 
back to the Operational state and the data rate at which the 
link is retrained is the initial data rate at which the link 
was initially trained. On the successful execution of the test, 
the link status is displayed as Active in the Hardware Status 
window. 

If the test fails, it indicates:

• Link is not up.

• Link width is not x1, x4, x8 or x16.

• Failure of transition to the correct Recovery substates.
Testing LTSSM State Transitions
Capture State Transitions Test

Description

Protocol Exerciser and DUT transits through various LTSSM 
states while performing LTSSM functions. This test can  
capture and display a maximum of 512 consecutive LTSSM 
state transitions of the Protocol Exerciser to check the 
sequence of LTSSM transitions and identify the state at 
which a problem occurred. 

Usage

When the link between the Protocol Exerciser and DUT is 
configured and operational, the link status is displayed in 
the Hardware Status window of the Protocol Exerciser GUI. 
The current state of link is reflected through this status 
(either No Link or Active). There may be situations when 
you want to troubleshoot the No Link status of the link by 
checking the LTSSM state transitions. In such situations, this 
test can provide you a trail of LTSSM state transitions to 
help you identify the source of problem in the link between 
DUT and Protocol Exerciser.

You can also use this test to check if the sequence of DUT's 
LTSSM state transitions for an LTSSM function is as per the 
PCIe specifications.

Test Results

If the test passes, the LTSSM state transitions are displayed 
in the test log along with the current link width and link 
status. 
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Protocol Exerciser GUI Reference

Dialog Boxes    84

Menus    87

Windows    90

This chapter provides description of each field, menu option, 
and toolbar option available in various windows and dialog 
boxes of the Protocol Exerciser GUI.
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Dialog Boxes

Open dialog box
84
To access this dialog: Select File > Open. Select the file to 
open. Then, click Open.
Port Selection dialog box

Component Description

Load following items The Load following items list box provides you an 
expandable/collapsible check box list of exerciser 
settings. Here, select only those settings that you 
want to load from the *.exs file.

Description of file The Description of file text box displays a brief 
description of the setup file, if exists.
Component Description

Module The Module column provides a list of modules in 
the form of check boxes. These check
boxes are organized under the expandable list of 
chassis to which they belong. Here,
select a module on which you want to start a new 
session.
A module, which is already associated with a 
session, appears disabled. 

Type The Type column shows the link width along with 
the speed of the port, such as 5.0Gb/s or 2.5Gb/s, 
at which it operates.

# Ports The # Ports column displays the number of ports 
available for each module. 

License The License column displays the license details of 
each module.
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Save dialog box

Status The Status column displays the status of each 
module. This column displays the following
messages:
• Rebooting: This message indicates that the 

serial I/O module is restarting.
• Ready: This message indicates that you can 

now add port to the session.
• Session_Name: Session_Name is the name of 

the session. This message indicates that the 
Session_Name session is now connected with 
the port.

Select Ports to use Select the port to use from the Select Ports to use 
list box. 

Component Description
Protocol Exerciser User’s Guide
To access this dialog: Select File > Save.
Select type of connection dialog box

Component Description

Save following items The Save following items list box provides you an 
expandable/collapsible check box list of exerciser 
settings. Here, select only those settings that you 
want to save in the *.exs file for later use.

Description for Setup file The Description for Setup file text box allows you 
to specify a brief description for the setup file.
To access this dialog: Click Start > Programs > Agilent SPT 
> PCIe Exerciser 8.1 Release > Exerciser GUI.
Component Description

Connect to existing session Select Connect to existing session if you want to 
use an existing session of Protocol Exerciser on a 
known server.
The existing session can be either initiated by the 
API or by another GUI since multiple GUIs can 
share the same session.
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Connect to new session Select Connect to new session if you want to 
create a new Protocol Exerciser session on a 
known server.

Offline mode Select Offline mode if you want to access the 
Protocol Exerciser GUI without connecting to the 
hardware.

Server Specifies the name or IP address of the server, 
where you want to start a new or join an existing 
Protocol Exerciser session. Its default value is 
localhost.

Get session list Click Get session list to retrieve a list of existing 
Protocol Exerciser sessions from the server you 
specified in the Server text box. This button 
works only if you have selected the Connect to 
existing session option.

Session list Displays a list of sessions existing on the server 
you specified in the Server text field.

Start Click Start to start a new Protocol Exerciser 
instance.

Exit Click Exit to close the dialog box without starting 
the Protocol Exerciser application.

Component Description
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Menus

Action Menu
Protocol Exerciser User’s Guide
The following is a brief description of the Action menu 
commands. Some of the options which are not supported in 
this release are disabled in the GUI.
Edit Menu

Menu command Description

Link Up Performs a Link-Up between Protocol Exerciser 
and DUT as per the configured link and lane 
settings.

Initiate Speed change Initiates speed change to the highest data rate 
advertised by both the link partners during link 
training. 

Initiate Retrain Link Retrains the Link.

Disable Exerciser Transmitter Disables the exerciser transmitter.

Reload Data Memory Reloads Data Memory from Exerciser.

Initialize Data Memory Opens a dialog to initialize the Exerciser Data 
Memory.
The following is a brief description of the Edit menu 
commands. 
File Menu

Menu command Description

Find in Data Memory Allows finding particular pattern in the Exerciser 
Data Memory.

Goto Data Memory Address Moves the cursor to a particular memory address 
of the Exerciser Data Memory.
The following is a brief description of the File menu 
commands.

Menu command Description

New Opens the port selection dialog box.
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Open Displays the Open dialog box that enables you to 
open the saved session information.

Save Displays the Save dialog box that enables you to 
save the session information. You can enter the 
location and a file name for the data to be saved. 
After confirming these entries an additional dialog 
pops up as seen i the figure below. You can define 
if all or a subset of the Exerciser setting should be 
saved. As default all possible data will be saved.

Save As Displays the Save As dialog box that enables you 
to specify the desired location to save the session 
information.

Close Closes the selected session.

Exit Closes the Protocol Exerciser application.

Menu command Description
Help Menu
The Help menu provides access to: 

Please have the complete version information available in 
case you need to contact Agilent support.

Menu command Description

Help Topics Opens the main help menu.

Session Information Provides an information dialog containing the IP 
address of the server the module is connected to, 
the session ID and the used module.

Version Information Provides an information dialog containing the 
software version number of the Exerciser 
solution, outlining the different elements of the 
solution.

About Displays the about dialog.
View Menu
The following is a brief description of the View menu 
commands.
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Menu command Description

Navigation Window Displays the Navigation Window.

Hardware Status Window Display the Hardware Status Window.
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Windows

General Function Equalization Settings tab
90
To access this function: Click General in the Navigation 
pane. Then, click the Equalization Settings tab. 

Refer to the topic Configuring Equalization Procedure 
Settings in the main online help of Protocol Exerciser to 
know more about the Equalization implementation in 
Protocol Exerciser.

The Equalization Settings tab is broadly divided into two 
groups -  5.0 GT/s and 8 GT/s allowing you to configure the 
Equalization settings separately for 5.0 GT/s and 8 GT/s 
speeds. The 8 GT/s group is further organized into two 
groups -  Request to DUT and Exerciser. The following table 
describes fields in all these groups and subgroups. 
Field Description

5.0 GT/s

De-emphasis shown in TS Provides options to specify the Tx De-emphasis settings in training sequences (TS1 
and TS2). You can set the de-emphasis level that the Protocol Exerciser will use for 
the transmission of training sequences at 5.0 GT/s.

8 GT/s

Request to DUT This group box provides options to configure the Equalization settings that the 
Protocol Exerciser will send to DUT in the training sequences to request DUT to use 
the specified presets and co-efficient values.

Tx Preset Value Options to set the Tx De-emphasis preset value that the Protocol Exerciser will send 
to DUT in the training sequences to request DUT to use the specified preset. 

Tx pre cursor coefficients Options to set the Tx coefficient –C1 value from the Tx Equalization Finite Impulse 
Response Filter.

Tx data cursor coefficients Options to set the Tx coefficient C0 value from the Tx Equalization Finite Impulse 
Response Filter.

Tx post cursor coefficients Options to set the Tx coefficient +C1 value from the Tx Equalization Finite Impulse 
Response Filter.

Rx preset hints Options to set the preset value that the Protocol Exerciser will send to the DUT as a 
Hint for the Rx Equalization value based on the trace length of the DUT.

Exerciser  This group box provides options to configure Equalization settings that the Protocol 
Exerciser will use and advertise as its Tx capabilities during the link training.

FS Options to set the value for Full Swing (FS) resolution for de-emphasis. Protocol 
Exerciser advertises this value in Phase 1 of Equalization.
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General Function Lane Settings tab

LF Options to set the value for Low Frequency (LF) resolution for de-emphasis.

Tx Preset Value Options to set the Tx De-emphasis preset value that the Protocol Exerciser 
advertises as its Tx capabilities during the link training at 8.0 GT/s. 

Tx pre cursor coefficients Options to set the Tx coefficient -C1 value  from the Tx Equalization Finite Impulse 
Response Filter. 
The three Tx co-efficient values set for the Exerciser should add up to the specified 
FS value.

Tx data cursor coefficients Options to set the Tx coefficient C0 value  from the Tx Equalization Finite Impulse 
Response Filter. 
The three Tx co-efficient values set for the Exerciser should add up to the specified 
FS value.

Tx post cursor coefficients Options to set the Tx coefficient +C1 value  from the Tx Equalization Finite Impulse 
Response Filter. 
The three Tx co-efficient values set for the Exerciser should add up to the specified 
FS value.

Ignore coefficient rule 
checks

Selecting these check boxes allow you to break the specified co-efficient rule(s) so 
that you can test how the DUT responds when a co-efficient rule is ignored.

Perform Equalization in 
Recovery @8 GT/s

The Perform Equalization in Recovery @8 GT/s option ensures that Protocol 
Exerciser (acting as a USC) must perform Equalization when upgrading the link 
speed to 8.0 GT/s.  If this option is not selected, then the link speed is  upgraded 
without performing equalization.
A USC performs the phases of equalization. Therefore, this option is applicable only 
for a USC and is disabled when Protocol Exerciser acts as a DSC, that is when the 
Session type is configured as ToUpstream.

Request Equalization in 
Recovery @8 GT/s

The Request Equalization in Recovery @8 GT/s option ensures that Protocol 
Exerciser (acting as a DSC) should request the USC to redo equalization.
This option is applicable only for a DSC. Therefore, this option is disabled when 
Protocol Exerciser acts as a USC, that is the Session type is configured as 
ToDownstream.

Perform Phase 2/Phase 3 Selecting the Perform Phase 2/Phase 3 option instructs Protocol Exerciser to 
perform the phase 2 and phase 3 of the Equalization procedure before moving the 
link to 8 GT/s. If this option is not selected, then Protocol Exerciser exits the 
Recovery.Equalization sub-state after phase 1 and transitions to the 
Recovery.RcvrLock substate to proceed towards achieving the 8.0 GT/s speed. 
A USC performs the phases of equalization. Therefore, this option is applicable only 
for a USC and is disabled when Protocol Exerciser acts as a DSC, that is when the 
Session type is configured as ToUpstream.

Field Description
Protocol Exerciser User’s Guide
To access this function: Click General in the Navigation 
pane. Then, click the Lane Settings tab.
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Field Description

Reverse Lanes Provides the following option buttons for 
transmitter (Tx):
• Yes: Select to enforce the lanes reversal 

manually on physical lanes by reversing the 
logical lane numbers.

• No: Select to not enforce lane reversal.

Lane Reversal Capability Provides the following option buttons for 
transmitter (Tx):
• Disabled: Automatically deactivates the lane 

reversal capability.
• Enabled: Automatically activates lane reversal 

capability when needed.

Lane Polarity Provides options to set the polarity of the 
individual lanes to Normal or Inverted for 
transmitter (Tx). Lane numbers available for lane 
polarity setting vary from 0 to 15 based on the 
advertised link width.  
General Function Link Settings tab
To access this function: Click General in the Navigation 
pane. Then, click the Link Settings tab.
Field Description

Supported Link Widths Enables you to specify the desired link width to use for data transfer. Here, only 
those link widths, which are supported by Protocol Exerciser, are available for 
selection. The link widths, which are not supported by Protocol Exerciser, are 
disabled. 
The x1 check box is by default selected. This is because the support for x1 is 
mandatory as per PCI Express specification.

Negotiated Link Width Displays the link width that Protocol Exerciser and DUT have agreed upon after 
link up.

Link number advertised Enables you to specify the link number that you want to advertise in training 
sequences. The link number specified here should be in the range of zero to 
255.

Data Rate Capability Enables you to the select the data rate capability of Protocol Exerciser. This 
data rate is advertised during the link training sequence to perform link speed 
negotiations.
You can select a data rate capability from the following options:
• 2.5 GT/s
• 5.0 GT/s - Advertised data rate is then 2.5 and 5.0 GT/s
• 8.0 GT/s - Advertised data rate is then 2.5, 5.0, and 8.0 GT/s
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General Function Symbol Settings tab

Autonomous speed 
change to 8 GT/s

Select this check box to enable autonomous speed change to the 8 GT/s 
speed. This ensures that Protocol Exerciser autonomously moves the link to 
8.0 GT/s during the link training if the data rate capability of both the link 
partners is 8.0 GT/s. If this option is selected, Protocol Exerciser must perform 
equalization at the first entry to 8GT/s after exit from the Detect State.
This option is applicable only when you are using Protocol Exerciser as a USC 
that is, the Session Type is configured as ToDownstream. 

Scrambler (2.5 GT/s and 
5.0 GT/s)

The Scrambler drop-down list provides the following options:
• Enabled: Selecting this option enables or disables scrambling of data 

depending on the state of the Disable Scrambling bit of the link partner 
during link training.

• Disabled: Selecting this option disables the scrambling of data and also sets 
the Disable Scrambling bit in the link control field of training sequences 
during link training.

This option is not applicable for 8 GT/s link speed. At the Gen3 speed, 
scrambling is always enabled to follow the new Gen3 Scrambling Rules as 
listed in the PCIe specifications.

Session Type The Session Type drop-down list provides the following options:
• To Downstream: Select this option when Protocol Exerciser emulates a root 

complex and you are testing a PCIe device at end point. The Protocol 
Exerciser then acts as an Upstream Component (USC) and performs the 
training sequences during its use as an LTSSM.

• To Upstream: Select this option when Protocol Exerciser emulates an end 
point and you are testing a PCIe device at root-complex. The Protocol 
Exerciser then acts as a Downstream Component (DSC) and responds to the 
training sequences during its use as an LTSSM.

Field Description
Protocol Exerciser User’s Guide
To access this function: Click General in the Navigation 
pane. Then, click the Symbol Settings tab.

Field Description

2.5 GT/s and 5.0 GT/s

SKP Interval (in number of 
symbols)

Enables you to specify the symbol time gap 
between two SKP ordered sets.

Number of SKP symbols in 
SKP ordered sets

Provides options to specify the number of SKP 
symbols, ranging between 1 to 5, to be included in 
an ordered set.

8.0 GT/s

SKP Interval (in number of 
blocks)

Enables you to specify the block time gap 
between two SKP ordered sets.
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Number of SKP symbols in 
SKP ordered sets

Provides options to specify the number of SKP 
symbols, ranging between 8 to 24, to be included 
in an ordered set.

Field Description
General Function Transceiver Settings tab
To access this function: Click General in the Navigation 
pane. Then, click the Transceiver Settings tab.

These settings control the Protocol Exerciser Tx and Rx 
equalization settings.

Refer to the topic Configuring Transceiver Settings in the 
main online help of Protocol Exerciser to know more.

Field Description

Tx output voltage This setting controls the maximum Vout before 
any pre-emphasis or de-emphasis (Vd). The 
default value is 900 mV. 

Tx Pre-emphasis Pre Tap This setting controls the amount of pre-emphasis 
(Vc). As you move towards a more negative value, 
you get more Pre-emphasis. 

Tx Pre-emphasis First Post 
Tap

Main De-emphasis value, which controls the 
amount of de-emphasis (Va). The higher the 
number, the higher is the de-emphasis. 

Tx Pre-emphasis Second 
Post Tap

Second post-tap De-emphasis. 

Rx Equalizer AC and DC 
Gain

These settings impact the Receiver equalization 
of the Protocol Exerciser. You can tune the Rx 
equalization by adjusting the AC and DC gain 
settings. Typically DC gain would be 0 or 3db gain. 
General function - Trigger Out tab
To access this function: Click General in the Navigation 
pane. Then, click the Trigger Out tab.
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Field Description

Status The Status section shows the following 
messages:
• Accumulated events: Shows a list of events 

that resulted in generating the trigger-out 
pulse since the last time you clicked Clear 
Status.

• First event: Shows which first events, which 
occurred in the same timestamp, resulted in 
generating the trigger-out pulse since the last 
time you clicked Clear Status.

Source Name The Source Name column displays a list of 
events, such as Protocol Error and Going Out of 
L0, which you can use as a source to generate a 
trigger-out pulse.

Enabled The Enabled column provides a check box for 
each event in the Source Name column. Here, 
select a the check box corresponding to a event 
that you want to use as a source to generate a 
trigger-out pulse.

Fired The Fired column shows the following messages 
for each event listed under the Source Name 
column:
• Fired: This message appears when the 

corresponding event has occurred.
• Not fired: This message appears when the 

corresponding event has not occurred.

Mask All Click Mask All to select all check boxes in the 
Enabled column. This, as a consequence, 
instructs Protocol Exerciser to trigger-out 
whenever one or more of the events listed under 
the Source Name column occur.

Unmask All Click Unmask All to clear all check boxes in the 
Enabled column.

Clear Status Click Clear Status to set the status of all events to 
Not fired.

Refresh Status Click Refresh Status to refresh the status of all 
the events.
LTSSM Tests
To access this page: Click the LTSSM Test icon in the 
Navigation window.
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Field Description

Select Test Case The Select Test Case pane has the following 
components:
• Test Case: The Test Case list box provides a list 

of LTSSM test cases that you can select to run. 
• Description: The Description list box displays 

the description of the selected test case. A test 
case description is divided into the following 
heads:
• Purpose: This head states what the test 

case intends to do. 
• Prerequisites: This head states what should 

already be in place before you run the test 
case.

• Observation: This head states the checks 
that are performed during the execution of a 
test case.

Sequence Overview The Sequence Overview section displays a 
flow-chart diagram to show the execution 
sequence of the selected test case.

Run Click Run to start executing the selected test 
case.

Stop Click Stop to halt the execution of the underlying 
test case.

Test Case State The Test Case State section displays the following 
states that an executing test case goes through:
• Running: Reflects that the test case is 

executing.
• Passed: Reflects that the test case is 

successfully executed.
• Failed: Reflects that executing test case is 

either cancelled by user or has met an 
unwarranted condition. You can cancel an 
executing test case by clicking the Stop button.

Log The Log pane displays the data describing the 
various stages of the underlying test case.
The Log pane has its own short-cut menu, which 
is displayed when you right-click anywhere inside 
it. This short-cut menu has the following 
commands:
• Clear Log: Clears the Log pane.
• Copy to Clipboard: Copies the data in the Log 

pane to clipboard.
• Save: Displays the Save log file dialog box, 

which you can use to save the data shown in 
the Log pane to a file in RTF or TXT format.
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Protocol Checker function
Protocol Exerciser User’s Guide
To access this function: Click Protocol Checker in the 
Navigation pane.

Field Description

Status The Status section shows the following 
components:
• Violated Rules: Shows a list of PCIe protocol 

rules that were violated since the last time you 
clicked Clear Status.

• First Violated: Shows which first rules of the 
PCIe protocol were violated in the same 
timestamp since the last time you clicked Clear 
Status.

Rule Name The Rule Name column displays a list of PCIe 
protocol rules, which you can select to observe 
for violation.

Enabled The Enabled column provides a check box for 
each rule in the Rule Name column. Here, select a 
the check box corresponding to a rule that you 
want to observe for violation.

Violation The Violation column shows the following 
messages for each rule listed under the Rule 
Name column:
• Violated: This message appears when the 

corresponding rule has been violated.
• Not Violated: This message appears when the 

corresponding rule has not been violated.

Mask All Click Mask All to select all check boxes in the 
Enabled column. Use this command button when 
you want to enable all the rules listed under the 
Rule Name column.

Unmask All Click Unmask All to clear all check boxes in the 
Enabled column.

Clear Status Click Clear Status to set the status of all events to 
Not violated.

Refresh Status Click Refresh Status to refresh the status of all 
the rules listed under the Rule Name column.
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Using Protocol Checker    100

This chapter provides information on the Protocol Checker 
function of the Protocol Exerciser application.
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100
Consider a situation in which you have linked up Protocol 
Exerciser with a DUT, and these two devices are transmitting 
data to each other. Now, you want to find out if the 
transmission between the two devices is adhering to the 
rules of the PCIe protocol. Or you want to test DUT by 
introducing a PCIe rule violation in the transmission, and 
want to see if that rule is actually violated. To help you in 
this situation, Protocol Exerciser provides you the Protocol 
Checker function.

The Protocol Checker function provides a list of PCIe 
protocol rules that you can select to observe them for 
violation. Once a protocol rule is enabled, Protocol Exerciser 
displays the name of rules in the Status pane of Protocol 
Checker when that rule is violated. 

To access the Protocol Checker function:

• Click the Protocol Checker icon in the Navigation pane.

The following screen displays the Protocol Checker pane 
with two protocol rules displayed as violated out of the four 
enabled rules.

Figure 17 Protocol Checker
Protocol Exerciser User’s Guide
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In this release, the following protocol checks are supported:

• Lane De- skew Error 

• Disparity Error Received  

• 8b/10b Coding Error Received 

• 128b/130b sync error 
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Using the Firmware Update Tool    104

This appendix provides information on the Firmware Update 
tool.
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The Firmware Update tool is automatically installed during 
the Protocol Exerciser installation. You use this tool to 
update the Controller PC with the new firmware for the 
selected Exerciser card. 

To access the Firmware Update tool:

Select Start > Programs > Agilent SPT > PCIe Exerciser 8.1 
Release - > Update GUI.

The Firmware Update window appears.

Figure 18 Firmware Update window
NOTE The cards shown with a grey background indicate that these are currently 
in use and cannot be updated. The cards displayed in red indicate that 
these cards need an update.
To Update the Firmware Version of the Exerciser Card

1 Select the Exerciser card, for which you want to update 
the Firmware, in the Please Select Device section.

2 Click Update FW.
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This instructs the Controller PC to check for the new 
Firmware version for the selected exerciser card. If there 
is any new version, the Controller PC uses it to update its 
existing Firmware version. 

Once the Controller PC is updated with the new 
firmware, the Status field in the Firmware Update tool 
shows Done.
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